
IBM MobileFirst Platform Foundation for iOS V7.1.0

Upgrading MobileFirst Server from
V6.2.0 to V7.1.0

IBM



Note
Before you use this information and the product it supports, read the information in “Notices” on page A-1.

IBM MobileFirst Platform Foundation for iOS V7.1.0

This edition applies to version V7.1.0 of IBM MobileFirst Platform Foundation for iOS and to all subsequent releases
and modifications until otherwise indicated in new editions.

This edition was updated last on 1 December 2015.

© Copyright IBM Corporation 2015.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Contents

Upgrading MobileFirst Server from
V6.2.0 to V7.1.0 . . . . . . . . . .. 1-1

Running IBM Installation Manager .. 2-1
Running Installation Manager in graphical mode 2-2
Running Installation Manager in command-line
mode . . . . . . . . . . . . . . .. 2-3

Updating the application server and
the databases . . . . . . . . . .. 3-1
Updating MobileFirst Server Administration
Service, MobileFirst Operations Console, and
MobileFirst runtime environment . . . . . .. 3-1

Upgrading the databases. . . . . . . .. 3-3
Upgrading the web applications . . . . .. 3-5
Upgrading Application Center . . . . .. 3-11
Reinstalling MobileFirst Operational Analytics 3-15

Support and comments . . . . . .. 4-1

Notices . . . . . . . . . . . . .. A-1
Trademarks . . . . . . . . . . . . .. A-3
Terms and conditions for product documentation A-3
IBM Online Privacy Statement . . . . . .. A-4

Index . . . . . . . . . . . . . .. X-1

© Copyright IBM Corp. 2015 iii



iv IBM MobileFirst Platform Foundation for iOS V7.1.0: Upgrading MobileFirst Server from V6.2.0 to V7.1.0



Upgrading MobileFirst Server from V6.2.0 to V7.1.0

IBM® Worklight® Foundation V6.2.0 and IBM MobileFirst™ Platform Foundation for
iOS V7.1.0 have a similar architecture from the installation and upgrading
perspective. However, you might consider the following differences:

Product renaming
The product is renamed from IBM Worklight Foundation to IBM
MobileFirst Platform Foundation for iOS in V6.3.0. This change modifies
the use of Installation Manager. Instead of updating IBM Worklight
Foundation, you must install IBM MobileFirst Platform Foundation for iOS
in the package group that contains Worklight. Installation Manager is
instructed to supersede IBM Worklight Foundation with IBM MobileFirst
Platform Foundation for iOS. The result is the same as an upgrade. This
renaming does not affect the rest of the upgrade procedure. You can
replace the WAR files of the application without loosing the configuration
that you define in the application server.

Session-independent mode by default
New applications that are developed with V7.1.0 are session-independent
by default. This choice can be overridden. For more information, see
Session-independent mode.
v This difference might have impact on:

– Your network infrastructure and the settings of your load balancers.
– The ability to auto-scale a cluster or server farm. For

session-independent applications, you can stop a server without
visible impact for the users.

– Your maintenance procedures. It is no longer true to assume that a
cluster that has some servers that are upgraded and other not
upgraded to a new configuration or fix pack level, has no impact on
existing sessions.

Support for token licensing
Token licensing is introduced in V7.1.0.
v If you have a contract that defines the use of token-based licensing for

the product, activate token licensing at upgrade time and configure your
application for token licensing.

v If you do not have a contract that defines the use of token-based
licensing, do not activate token licensing at upgrade time. With token
licensing activated, MobileFirst Server does not start unless it is
configured to retrieve tokens from a Rational® License Key Server and
obtains enough tokens to run.

WorklightReports database is deprecated
If you rely on this database for application monitoring, consider installing
MobileFirst Operational Analytics. For more information, see Installing the
IBM MobileFirst Platform Operational Analytics.

IBM Worklight Analytics Platform changes
IBM Worklight Analytics Platform is repackaged and renamed as
MobileFirst Operational Analytics. In V7.1.0, the component is delivered as
two separate WAR files instead of a single WAR file. One for the analytics
console and one for the analytics service. Both WAR files are protected by
the security roles.
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Changes in database schema
The database schema is changed in V7.1.0. Some tables or columns are
dropped in Application Center and MobileFirst Server Administration
Service databases. The SSO_LOGIN_CONTEXTS table is cleared in the runtime
databases. New tables, columns, and indexes are added. You might want to
make a backup of the databases before you run the database migration
scripts because certain operations that are run cannot be undone.

Installation of Application Center with Ant tasks
From V7.1.0, Application Center can be installed by Ant tasks. Installing
Application Center with Ant tasks, instead of Installation Manager, enables
you to decouple updates to the server from updates to the Application
Center.

If Application Center is installed with Installation Manager, to benefit from
this feature and update Application Center with Ant tasks, you need to
uninstall Application Center first. Uninstall Application Center with
Installation Manager, reinstall it with Ant tasks and then reconfigure it. For
more information, see “Installing and upgrading of Application Center
with Ant tasks” on page 3-13 before you run the Installation Manager.

Asymmetric deployment
On WebSphere® Application Server Network Deployment, V7.1.0 supports
Asymmetric deployment with runtimes and administration services in
different server or cluster. This topology is also supported in previous
versions through APAR PI35384 but it is not the case when V6.2.0 is first
released.

If you want to take advantage of this topology, you need to uninstall the
MobileFirst Server Administration Service from one cluster, reinstall it to
another cluster, and reconfigure it at “Updating the application server and
the databases” on page 3-1. This operation (uninstallation and
reinstallation) is not possible with the Server Configuration Tool. The tool
does not support asymmetric deployment. It can be done with Ant tasks,
or manual installation. After you reinstall the MobileFirst Server
Administration Service and the console with Ant task, you need to
configure it.

Simplification of the server farm configuration
The configuration of a server farm is simplified. In particular, there is no
need to maintain a file with the list of all members of a farm. For more
information about how to simplify the configuration, see “Updating the
configuration of your server farm” on page 3-10.

The high-level procedure is as follows:
1. Run IBM Installation Manager. See “Running IBM Installation Manager” on

page 2-1.
2. Back up the databases before you upgrade the components.

Note: The operations that are run in the upgrade scripts cannot be undone.
3. Stop all the application servers and upgrade the database.
4. Update the application servers for MobileFirst Server, Application Center, and

MobileFirst Operational Analytics. See “Updating the application server and the
databases” on page 3-1.

Note:
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v Application Center can be handled independently from the other
components.

v MobileFirst Server, and MobileFirst Operational Analytics need to be
upgraded simultaneously.

5. Restart the application server.
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Running IBM Installation Manager

About this task

First, run Installation Manager to update the binary files of IBM MobileFirst
Platform Foundation for iOS on your disk. Then, update the MobileFirst Server
components on your application server by following the steps that are described in
“Updating the application server and the databases” on page 3-1.

Installation Manager can be run in two ways: by graphical user interface (GUI), or
by command-line. The effect of running Installation Manager to upgrade to V7.1.0
depends on the choice that you made at the initial installation.

If Application Center is installed at the initial installation and deployed to an
application server, Installation Manager updates Application Center in the
application server. It also updates the Application Center database to set the
version number to 7.1.0. If Installation Manager fails to find Application Center on
the application server (such Application Center WAR file is removed), the update
fails, and Installation Manager fails to apply the upgrade.

If Application Center is not installed at the initial installation and deployed to an
application server, Installation Manager updates only the binary files on your disk.
This operation usually does not fail unless an error occurs during the updating of
the files. For example, on Windows environment, you run a process (such as Ant
task or the Server Configuration Tool) inside the MobileFirst installation directory
while you apply the update.

Tip: To determine whether Application Center is installed with Installation
Manager, you can check the registry of Installation Manager.
v If you run Installation Manager in GUI mode, the choice is displayed in the

wizard pane when you are at the Configuration Choice panel.
v If you do not run Installation Manager in GUI mode, you can look at the content

of the product_install_dir/shortcuts/application-center.sh file.
– If it contains the line

url=’${appserver.root.url}${appserver.appcenter.console.path}’, it means
that Application Center is not installed by Installation Manager.

– If it contains a URL that is defined (such as url=’http://localhost:9080/
appcenterconsole/’), it means that Application Center is installed by
Installation Manager.

The product is renamed from IBM Worklight Foundation to IBM MobileFirst
Platform Foundation for iOS in V6.3.0. This change modifies the use of Installation
Manager. Instead of updating IBM Worklight Foundation, you must install IBM
MobileFirst Platform Foundation for iOS in the package group that contains
Worklight. Installation Manager is instructed to supersede IBM Worklight
Foundation with IBM MobileFirst Platform Foundation for iOS. The result is the
same as an upgrade.
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Running Installation Manager in graphical mode
Procedure
1. Run Installation Manager from the user account that is used at the initial

installation.
To apply an update, Installation Manager must run with the same list of
registry files that are used at the initial installation. The list of Software that is
installed and the options that are used during the installation time are stored in
those registry files. If you run Installation Manager in administrator mode, the
registry files are installed at the system level. In /var folder on UNIX or Linux.
In c:\ProgramData folder on Windows. The location is independent from the
user who runs Installation Manager (although root is needed on UNIX and
Linux). However, if you run Installation Manager in single user mode, the
registry files are stored by default in the user's home directory.

2. Select File > Preferences.
Enter the repository of IBM MobileFirst Platform Foundation for iOS V7.1.0 and
also the repository of the fix pack if you plan to upgrade to a fix pack or
interim fix. The fix packs are delivered as delta installers and cannot be
installed if the base version is not among the listed repositories.
If you decompress the base installer in 710_installer_directory folder, the
repository file to enter is 710_installer_directory/
MobileFirst_Platform_Server/disk1/diskTag.inf. If you decompress the
interim fix file in ifix_directory folder, the repository file to enter is
ifix_directory/MobileFirst_Platform_Server/disk1/diskTag.inf.

3. After the repositories are entered, click OK to close the Preferences display.
4. Click Install. After you accept the license terms of IBM MobileFirst Platform

Foundation for iOS V7.1.0, Installation Manager displays a list of packages that
are already installed.
a. Verify that your IBM Worklight Foundation V6.2.0 installation is in list and

is not disabled.
b. Select the package group that contains the installation of V6.2.0 that you

need to update. By default, it is named as IBM Worklight. The name might
change due to the following scenarios:

v If you have multiple installations of IBM Worklight, a suffix might be
appended to the package name. For example, IBM Worklight_2.

v If you install the product with a version earlier than V6.0.0, the package
name uses the name of the product for that version. For example, Worklight
for the product name that is installed for V5.0.6, and then upgraded to
V6.2.0.

v If the package is not in the list, the cause might be that you did not run
Installation Manager with the same user account that was used at the initial
installation. Either find the user account that was used to run Installation
Manager, or make a fresh installation of the product and the interim fix by
clicking Install instead of Update.
– If you need to make a fresh installation, but Application Center is already

installed with Installation Manager, the procedure does not update
Application Center in the application server.

– If Application Center is installed with Installation Manager, but the
package is not found when you click Update, then you have to update
Application Center manually.

5. Click Next. You must determine whether you need to activate token licensing
or not. Token Licensing is a new feature that is introduced in V7.1.0.
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v If you do not have a contract to use token licensing with the Rational License
Key Server, click Do not activate token licensing.

v If you activate token licensing, make sure that the Rational License Key
Server is configured, and enough tokens can be obtained to run MobileFirst
Server and the applications it serves. Otherwise, the MobileFirst Server
administration application and the runtime environments cannot be run.

All choices are disabled in the panes, excepted some passwords (databases and
server administrator) that you can update if they are modified since the last
installation.

6. In the Thank You panel, click Next. A summary is displayed.
7. Click Update to start the update procedure.

What to do next

“Updating the application server and the databases” on page 3-1

Running Installation Manager in command-line mode
Procedure
1. Download the silent install files from http://public.dhe.ibm.com/software/

products/en/MobileFirstPlatform/docs/v710/Silent_Install_Sample_Files.zip.
2. Decompress the file, and select 7.1/upgrade-initially-worklightv6.xml file.

If you initially installed the product in V5.x, select this 7.1/upgrade-initially-
worklightv5.xml file instead.
The file contains the profile identity of the product. The default value of this
identity changes over the releases of the product. In V5.x, it is Worklight. In
V6.0.0, V6.1.0, and V6.2.0, it is IBM Worklight. In V6.3.0, V7.0.0, and V7.1.0, it is
IBM MobileFirst Platform Server.

3. Make a copy of the file you selected.
4. Open the copied XML file with a text editor or XML editor. Modify the

following elements:
a. The repository element that defines the repository list.

Create a repository entry for the repository of IBM MobileFirst Platform
Foundation for iOS V7.1.0 and also the repository of the fix pack that you
plan to upgrade. The fix packs are delivered as delta installers and cannot
be installed if the base version is not among the listed repositories.
If you decompress the base installer in 710_installer_directory folder, the
repository file to enter is 710_installer_directory/
MobileFirst_Platform_Server/disk1/diskTag.inf. If you decompress the
interim fix file in ifix_directory folder, the repository file to enter is
ifix_directory/MobileFirst_Platform_Server/disk1/diskTag.inf.

b. Optional: Update the passwords for the database and the application server.
If Application Center is installed at the initial installation with Installation
Manager, and the passwords for the database or the application server are
changed, you can modify the value in the XML file. These passwords are
used to validate that the database has the right schema version, and to
upgrade it if it is in a version older than V7.1.0. They are also used to run
wsadmin for an installation of Application Center on WebSphere Application
Server full profile. Uncomment the appropriate lines in the XML file:

<!-- Optional: If the password of the WAS administrator has changed-->
<!-- <data key=’user.appserver.was.admin.password2’ value=’password’/> -->
<!-- Optional: If the password used to access the DB2 database for
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Application Center has changed, you may specify it here-->
<!-- <data key=’user.database.db2.appcenter.password’ value=’password’/> -->
<!-- Optional: If the password used to access the MySQL database for

Application Center has changed, you may specify it here -->
<!-- <data key=’user.database.mysql.appcenter.password’ value=’password’/> -->
<!-- Optional: If the password used to access the Oracle database for

Application Center has changed, you may specify it here -->
<!-- <data key=’user.database.oracle.appcenter.password’ value=’password’/> -->

c. Uncomment the line <data key=’user.licensed.by.tokens’
value=’false’/>. Set the value to true if you have a contract to use token
licensing with the Rational License Key Server. Otherwise, set the value to
false. If you activate token licensing, make sure that the Rational License
Key Server is configured, and enough tokens can be obtained to run
MobileFirst Server and the applications it serves. Otherwise, the MobileFirst
Server administration application and the runtime environment cannot be
run.

Restriction: After the decision is made to activate token licensing or not, it
cannot be modified. If you run an upgrade with the value true, and later
apply a fix pack with the value false, the second upgrade fails.

d. Review the profile identity and the installation location. The profile identity
and the installation location must match what is installed:
v This line: <profile id=’IBM Worklight’ installLocation=’/opt/IBM/

Worklight’>

v And this line: <offering id=’com.ibm.mobilefirst.foundation.server’
version=’7.1.0.00-20150913-2345’ profile=’IBM Worklight’
features=’main.feature’ installFixes=’none’/>

v To review the profile identity and the installation directories that are
known to Installation Manager, you can type the command:
installation_manager_path/eclipse/tools/imcl listInstallationDirectories -verbose

e. Update the version attribute to and set it to the version of the interim fix.
v If you install the base version that is downloaded from Passport

Advantage®, you do not need to do anything. The silent response files
contain the particular version that is posted on the Passport Advantage.

v If you install the base version with an interim fix (such
as7.1.0.0-IF201510051721), replace <offering
id=’com.ibm.mobilefirst.foundation.server’ version=’7.1.0.00-
20150913-2345’ profile=’IBM Worklight’ features=’main.feature’
installFixes=’none’/> by <offering
id=’com.ibm.mobilefirst.foundation.server’ version=’7.1.0.00-
20151005-1721’ profile=’IBM Worklight’ features=’main.feature’
installFixes=’none’/>.

Installation Manager does not only use the repositories that are listed in the
installation file, but also the repositories that are installed in its preferences.
Specifying the version attribute in the offering element is optional.
However, by specifying it, you ensure that the interim fix that is defined is
the version that you intend to install. This specification overrides the other
repositories with interim fixes that are listed in the Installation Manager
preferences.
You can also find the version number in ifix_directory/
MobileFirst_Platform_Server/disk1/md/repository.xml file, in the line
<offering id=.... version=’6.2.0.00-20141005-1729’>.

5. Open a session with the user account that is used at the initial installation.
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To apply an update, Installation Manager must run with the same list of
registry files that are used at the initial installation. The list of Software that is
installed and the options that are used during the installation time are stored in
those registry files. If you run Installation Manager in administrator mode, the
registry files are installed at the system level. In /var folder on UNIX or Linux.
In c:\ProgramData folder on Windows. The location is independent from the
user who runs Installation Manager (although root is needed on UNIX and
Linux). However, if you run Installation Manager in single user mode, the
registry files are stored by default in the user's home directory.

6. Run the command installation_manager_path/eclipse/tools/imcl input
<responseFile> -log /tmp/installwl.log -acceptLicense

Where
v <responseFile> is the XML file that you edit in 4 on page 2-3.
v -log /tmp/installwl.log is optional. It specifies a log file for the output of

Installation Manager.
v -acceptLicense is mandatory. It means that you accept the license terms of

IBM MobileFirst Platform Foundation for iOS V7.1.0. Without that option,
Installation Manager cannot proceed with the update.

What to do next

“Updating the application server and the databases” on page 3-1
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Updating the application server and the databases

About this task

IBM MobileFirst Platform Foundation for iOS provides several components that
you might have installed. Here is a description of their dependencies to update
them:

MobileFirst Server Administration Service, MobileFirst Operations Console, and
MobileFirst runtime environment

These three components compose as MobileFirst Server. They must be
updated together.

Although the runtime environment is provided by your development team
and built with MobileFirst Platform Command Line Interface for iOS (CLI),
it is not necessary to recompile the project and applications with CLI
V7.1.0 when you upgrade your server to V7.1.0. It is possible to separate
these lifecycles. However, you need to migrate the project WAR file to
make it compatible with V7.1.0. The following instructions include the step
to migrate the project WAR file so that it is binary compatible with V7.1.0.

You can continue to upload the applications and adapters that are built
with V6.2.0 to that runtime environment after you migrate the server to
V7.1.0. However, do not upload the applications and adapters that are built
with V7.1.0. For more information, see Version compatibility.

To deploy the applications that are built with V7.1.0, you have the
following two choices.
v Add a MobileFirst runtime environment with its own database. Do not

share the database between different runtimes.
v Replace the deployed runtime environment by a runtime environment

that is built with V7.1.0, at the condition that its configuration is
compatible with the applications that are built with V6.2.0. For example,
a session-independent configuration would not be compatible with the
applications that are developed with V6.2.0. For V7.0.0 or earlier, the
runtime application is configured for session-dependent mode by
default.

Application Center
The installation of this component is optional. This component is
independent of the other components. It can be run at a different interim
fix level than the others if needed.

MobileFirst Operational Analytics
The installation of this component is optional. The MobileFirst components
send data to MobileFirst Operational Analytics via a REST API. If this
component is installed, you must upgrade it when you upgrade the server.

Updating MobileFirst Server Administration Service, MobileFirst
Operations Console, and MobileFirst runtime environment

About this task

You can update these components in three ways:
v With the Server Configuration Tool

© Copyright IBM Corp. 2015 3-1

https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.upgrade.doc/devenv/c_compat.html?lang=en


v With Ant tasks
v Manually

The updating procedure depends on the method you used at the initial installation.

The product is installed with the Server Configuration Tool

v You can upgrade with the Server Configuration Tool.
v You can upgrade with Ant tasks. The Server Configuration Tool can

export the Ant files of a configuration by using File > Export
Configuration as Ant files.... When you select this option, you are
prompted to select a directory. A subdirectory that is named after the
name of the configuration is created in the directory you selected. An
Ant file for the Administration Service is saved in this subdirectory. One
subdirectory per runtime environment is also created in this
configuration directory. It is named after the name of the runtime in the
configuration. An Ant file for this runtime is also saved in the
subdirectory.

v You can upgrade manually.

The product is installed with Ant tasks

v You can upgrade with Ant tasks. Use the Ant tasks that are created at
initial installation. This way, you are certain to have the same parameters
as the initial installation.

v You can upgrade manually.

The product is installed manually

v You can upgrade manually.
v An attempt to upgrade with Ant tasks might fail. The target of the Ant

tasks to upgrade the product assume that the installation is made in a
certain way.

Important:

v Upgrade the database by a database administrator:
In some cases, you might want to upgrade the databases manually. For example,
to set some non-default properties to the new tables created. When you run an
upgrade with Server Configuration Tool, it looks at the value in the tables (such
as WORKLIGHT_VERSION for a runtime database) and detects that the tables are
already upgraded to V7.1.0. Thus, the tool would not attempt to upgrade them.
When you use Ant tasks, do not run the database and admdatabases targets if
the databases are already updated manually. If you do run them, the Ant tasks
would detect that the schema is in V7.1.0.

v Impact on high availability:
You need to stop the application servers that run the MobileFirst applications
until all your cluster or farm is upgraded.

v WebSphere Application Server specifics:
– The user that runs the upgrade needs to have at least the privileges of a

Deployer role to update the WAR files and a shared library.
– The order of operations is important. Make sure that you follow the sequence

that is described in the following sections to update the MobileFirst Server
Administration component first. Then, the runtime environments. If the
runtime environments fail to synchronize with the MobileFirst Server
Administration (such as JMX binary incompatibility that is introduced in the
fix pack), they would fail to start.
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– If your application server is WebSphere Application Server V7.0, you must
add the configuration property
com.ibm.ws.webcontainer.invokerequestlistenerforfilter = true. For more
information about how to add this property, see Configuring WebSphere
Application Server V7.0. This setting is required for the runtime environment
(the Project WAR File) in V7.1.0.

v All application servers must be stopped. All procedures in the following tasks
assume that the application servers running the MobileFirst applications are
stopped until the upgrade of all components is complete.

Upgrading the databases
About this task

This task is optional if you upgrade with the Server Configuration Tool.

Important: Back up the databases for MobileFirst Server Administration Service,
and the MobileFirst runtime environments. The migration scripts delete some data
in your database and the operation cannot be undone. If you decide to roll back
the upgrade of MobileFirst Server, you need this backup.

Upgrading the databases with Ant tasks
Run the admdatabases and databases targets to upgrade the WorklightAdmin and
Worklight databases.

Procedure
1. Use the Ant file that is used at initial installation. This way, you are certain to

have the same parameters as the initial installation.
a. Open the Ant file and verify the value of the worklight.server.install.dir

property.
Make sure that worklight.server.install.dir points to the installation of
the product that contains V7.1.0 installation. The Ant tasks update the
application server with the database scripts that are found in the JAR files
in this installation directory. If the property points to an installation that is
not V7.1.0, the update to the application server is not to the right level. To
verify that the product installation directory contains the expected version,
open product_install_dir/README.html. This file contains the build
number. For example, if you install V7.1.0 with the interim fix IFIX
7.1.0.0-IF201510051721 is installed, the build number in the README.html
file must contain this line: Build number: IMF 00-20151005-1721.

b. Verify the passwords.
The Ant file might contain ************ as value for the passwords. You
need exactly 12 stars (************) if you want the password to be
prompted interactively (such as during the deployment on WebSphere
Application Server).
If the value is defined in the Ant file, verify that the passwords are still up
to date.

2. Optional: You might alternatively consider building an Ant file from the model
of the configuration samples that are provided in product_install_dir/
WorklightServer/configuration-samples folder. They differ from the V6.2.0 Ant
files in the following ways:
v The WorklightReports database is not included, and is not created or

upgraded.
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v There is a possibility to enter the parameters to connect a MobileFirst
runtime environment to a MobileFirst Operational Analytics component.

v When an Ant file that does not contain the WorklightReports data source
specification is run to upgrade a V71 installation, it adds (or modifies) a
JNDI property (reports.exportRawData) and set its value to false. This
setting ensures that no data is exported to the Reports database.

Note: If you create an Ant file from the configuration samples that are
provided in product_install_dir/WorklightServer/configuration-samples
folder, verify that the parameters you use are the same as the one you used at
the initial installation. Verify the parameter details such as the server name, the
cluster name, the database, the users, and the schemas. If the database
parameters are different than the ones that are used at the initial installation,
the Ant task might create new empty tables instead of upgrading the tables to
the new format. If the application servers parameters are not the same as the
ones that used at the initial installation, the Ant task might fail to update the
application.

3. Run the admdatabases target to upgrade the WorklightAdmin database. For
example,
product_install_dir/shortcuts/ant -f your_ant_file.xml admdatabases

4. Run the databases target to upgrade the Worklight databases. For example,
product_install_dir/shortcuts/ant -f your_ant_file.xml databases

Note: You need to run this step 4 on each runtime environment if you have
more than one runtime environment.

Upgrading the databases manually
Upgrade the databases by using the upgrade scripts that are provided in
product_install_dir/WorklightServer/databases.

Procedure
1. Select the script, depending on your database, to upgrade the Administration

database. The upgrade is done in three steps. First, you need to upgrade the
database to V6.3.0. Then, from V6.3.0 to V7.0.0, and lastly to V7.1.0.
a. Choose one of the scripts to upgrade the database from V6.2.0 to V6.3.0:
v upgrade-worklightadmin-62-63-db2.sql

v upgrade-worklightadmin-62-63-mysql.sql

v upgrade-worklightadmin-62-63-oracle.sql

b. Then, upgrade the database from V6.3.0 to V7.0.0.
v upgrade-worklightadmin-63-70-db2.sql

v upgrade-worklightadmin-63-70-mysql.sql

v upgrade-worklightadmin-63-70-oracle.sql

c. Lastly, upgrade the database from V7.0.0 to V7.1.0.
v upgrade-worklightadmin-70-71-db2.sql

v upgrade-worklightadmin-70-71-mysql.sql

v upgrade-worklightadmin-70-71-oracle.sql

2. Select the script, depending on your database, to upgrade the Runtime
databases. The upgrade is done in three steps. First, you need to upgrade the
database to V6.3.0. Then, from V6.3.0 to V7.0.0, and lastly to V7.1.0.
a. Upgrade the database from V6.2.0 to V6.3.0 by using one of the following

scripts:
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v upgrade-worklight-62-63-db2.sql

v upgrade-worklight-62-63-mysql.sql

v upgrade-worklight-62-63-oracle.sql

b. Then, upgrade the database from V6.3.0 to V7.0.0.
v upgrade-worklight-63-70-db2.sql

v upgrade-worklight-63-70-mysql.sql

v upgrade-worklight-63-70-oracle.sql

c. Lastly, upgrade the database from V7.0.0 to V7.1.0.
v upgrade-worklight-70-71-db2.sql

v upgrade-worklight-70-71-mysql.sql

v upgrade-worklight-70-71-oracle.sql

Note: If several runtime environments (also know as the project WAR files) are
installed, you have several instances of that database, one per runtime
environment.

3. The reports database is deprecated in V7.1.0. However, if you still plan to use
them, select the script, depending on your database, to upgrade the Reports
database for the runtime environment.
a. Upgrade the database from V6.2.0 to V6.3.0 by using one of the following

scripts:
v upgrade-worklightreports-62-63-db2.sql

v upgrade-worklightreports-62-63-mysql.sql

v upgrade-worklightreports-62-63-oracle.sql

b. Then, upgrade the database from V6.3.0 to V7.0.0.
v upgrade-worklightreports-63-70-db2.sql

v upgrade-worklightreports-63-70-mysql.sql

v upgrade-worklightreports-63-70-oracle.sql

c. Lastly, upgrade the database from V7.0.0 to V7.1.0.
v upgrade-worklightreports-70-71-db2.sql

v upgrade-worklightreports-70-71-mysql.sql

v upgrade-worklightreports-70-71-oracle.sql

Note: If you are not using the reports feature, do not upgrade the databases.
Make sure that your applications do not export data to the reports database by
setting the value of the JNDI property (reports.exportRawData) to false.

Upgrading the web applications
Follow the instructions to upgrade the web applications of MobileFirst Server
Administration Service, MobileFirst Operations Console, and MobileFirst runtime
environments.

About this task

The runtime environment that is referred by this procedure is the project WAR file.
This WAR file is provided by your development team and built with MobileFirst
Platform Command Line Interface for iOS (CLI). It is not necessary to recompile
the project and applications with CLI V7.1.0 when you upgrade your server to
V7.1.0. It is possible to separate these lifecycles. However, you need to migrate the
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project WAR file to make it compatible with V7.1.0. The following instructions
include the step to migrate the project WAR file so that it is binary compatible
with V7.1.0.

You can continue to upload the applications and adapters that are built with V6.2.0
to that runtime environment after you migrate the server to V7.1.0. However, do
not upload the applications and adapters that are built with V7.1.0. For more
information, see Version compatibility.

To deploy the applications that are built with V7.1.0, you have the following two
choices.
v Add a MobileFirst runtime environment with its own database. Do not share the

database between different runtimes.
v Replace the deployed runtime environment by a runtime environment that is

built with V7.1.0, at the condition that its configuration is compatible with the
applications that are built with V6.2.0. For example, a session-independent
configuration would not be compatible with the applications that are developed
with V6.2.0. For V7.0.0 or earlier, the runtime application is configured for
session-dependent mode by default.

Upgrading with the Server Configuration Tool
About this task

This procedure upgrades the databases as well if it is not manually done before.
The Server Configuration Tool looks at the value in the XXX_VERSION table. For
example, WORKLIGHT_VERSION for a runtime database.

Important: Back up the databases for MobileFirst Server Administration Service,
and the MobileFirst runtime environments. The migration scripts delete some data
in your database and the operation cannot be undone. If you decide to roll back
the upgrade of MobileFirst Server, you need this backup.

Procedure
1. Start the Server Configuration Tool from the V7.1.0 product installation.

Note: If the Server Configuration Tool does not show your configuration files,
review the directory that it uses for the configuration files in the menu File >
Preferences. In general, the Server Configuration Tool uses the same default
directory as you had in V6.2.0. However, in some non-standard upgrade
scenarios, it might be reset to the default value for V7.1.0. On Windows, the
default directory for V7.1.0 is Documents\IBM MobileFirst Platform Server
Data\Server Configuration Tool. On UNIX, the default value is
home_dir/mobilefirst_platform_server/server-configuration-tool/.
To verify that the Server Configuration Tool runs the version that you want to
upgrade to, open the menu Help > About the Server Configuration Tool. A
dialog appears with the build number. It must match the version that you
install with Installation Manager. For example, make sure that the build
number of the Server Configuration Tool is 7.1.0.00.20151005-1721 if V7.1.0
and the interim fix 7.1.0.0-IF201510051721 are installed.
The Server Configuration Tool updates the application server with the WAR
files and JAR files that it finds in its installation directory. If you start the Server
Configuration Tool from a product installation that does not contain the correct
fix pack or interim fix, it will not update the application server to the right
level.

2. Select the configuration to update.
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3. Select Configurations > Upgrade a Previous Configuration. A dialog opens.
a. Enter the requested passwords (database / application server).
b. Verify the path of the project WAR file (runtime path).

If the path is not to the most current project WAR file that is deployed to
the application server, update the path. This WAR file is to be migrated (to
be binary compatible with the worklight-jee-library.jar of the fix pack or
interim fix) and redeployed to the application server. The base name of the
project WAR file must be the same as the one that is previously installed.

c. Click OK.
d. The upgrade starts. The Server Configuration Tool connects to the databases

to upgrade them to V7.1.0 schema if needed. If they are not at version 7.1.0,
it upgrades them.

4. Restart the application server.

Upgrading with Ant tasks
Before you begin

You must upgrade the databases before you run this procedure. See “Upgrading
the databases” on page 3-3.

About this task

Run the minimal-admupdate target to update the Administration Service WAR file.
Then, run the minimal-update target to update the runtime WAR file and the
worklight-jee-library.jar library. Restart the application server for these updates
to take effect.

Procedure
1. Optional: If the databases are already upgraded with an Ant file, and you

verify that the parameters in the Ant file are updated for V7.1.0, you can skip
this step. Otherwise, read the following instructions to edit the Ant file that is
used at the initial installation. This way, you are certain to have the same
parameters as the initial installation.
a. Open the Ant file and verify the value of the worklight.server.install.dir

property.
Make sure that worklight.server.install.dir points to the installation of
the product that contains the interim fix. The Ant tasks update the
application server with the WAR files and JAR files that it finds in this
installation directory. If the property points to an installation without the
interim fix, the update to the application server is not to the right level. To
verify that the product installation directory contains the interim fix, open
product_install_dir/README.html. This file contains the build number. For
example, if interim fix IFIX 7.1.0.0-IF201510051721 is installed, the build
number in the README.html file must contain this line: Build number: IMF
00-20151005-1721.

b. Verify the value of the worklight.project.war.file property in the Ant file.
If the path is not to the most current project WAR file that is deployed to
the application server, update the path. This WAR file is to be migrated (to
be binary compatible with the worklight-jee-library.jar of the fix pack or
interim fix) and redeployed to the application server. The base name of the
project WAR file must be the same as the one that is previously installed.

c. Verify the passwords.
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The Ant file might contain ************ as value for the passwords. You
need exactly 12 stars (************) if you want the password to be
prompted interactively (such as during the deployment on WebSphere
Application Server).
If the value is defined in the Ant file, verify that the passwords are still up
to date.

2. Optional: You might alternatively consider building an Ant file from the model
of the configuration samples that are provided in product_install_dir/
WorklightServer/configuration-samples folder. They differ from the V6.3.0 Ant
files in the following ways:
v The WorklightReports database is not included, and is not created or

upgraded.
v There is a possibility to enter the parameters to connect a MobileFirst

runtime environment to a MobileFirst Operational Analytics component.
v When an Ant file that does not contain the WorklightReports data source

specification is run to upgrade a V71 installation, it adds (or modifies) a
JNDI property (reports.exportRawData) and set its value to false. This
setting ensures that no data is exported to the Reports database.

Note: If you create an Ant file from the configuration samples that are
provided in product_install_dir/WorklightServer/configuration-samples
folder, verify that the parameters you use are the same as the one you used at
the initial installation. Verify the parameter details such as the server name, the
cluster name, the database, the users, and the schemas. If the database
parameters are different than the ones that are used at the initial installation,
the Ant task might create new empty tables instead of upgrading the tables to
the new format. If the application servers parameters are not the same as the
ones that used at the initial installation, the Ant task might fail to update the
application.

3. Run the minimal-admupdate target to update the MobileFirst Server
Administration Service and MobileFirst Operations Console WAR files. For
example,
product_install_dir/shortcuts/ant -f your_ant_file.xml minimal-admupdate

4. Run the minimal-update target to update each MobileFirst runtime
environment. For example,
product_install_dir/shortcuts/ant -f your_ant_file.xml minimal-update

This minimal-update target makes a copy of the project WAR file that is
specified by the property worklight.project.war.file and migrates the copy
so that it is binary compatible with the new worklight-jee-library.jar library.
It also installs this copy of the WAR file into the application server and updates
the worklight-jee-library.jar library.

5. Restart the application server for these updates to take effect.
6. Repeat this operation for all the servers of a farm.

Upgrading manually
Before you begin

You must upgrade the databases before you run this procedure. See “Upgrading
the databases” on page 3-3.
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Procedure
1. Locate the WAR and JAR files. The new versions of these files that you need to

update are in product_install_dir/WorklightServer folder.
2. Replace the worklightadmin.war and worklightconsole.war files in your

application server.

Note: For WebSphere Application Server full profile, make sure that the
configured values of the JNDI properties are not erased.

3. Replace the worklight-jee-library.jar library.
4. Migrate the project WAR file (MobileFirst runtime WAR file) so that it is binary

compatible with the upgraded worklight-jee-library.jar library.
a. Find the most current version of the project WAR file that is published by

your development team.
b. Migrate the project WAR file as described in Migrating a project WAR file

for use with a new MobileFirst Server.
c. Replace the project WAR file in your application server.
d. On WebSphere Application Server Network Deployment, do a full

synchronization of the servers.
5. Restart the application servers for these updates to take effect.
6. Update DB2® schema names.

WebSphere Application Server Liberty profile:

a. Edit the server.xml file in the usr/servers/serverName directory.
b. Look for the <properties.db2.jcc .../> element in the <dataSource

jndiName="contextroot/jdbc/WorklightDS" ...> and <dataSource
jndiName="contextroot/jdbc/WorklightReportsDS" ...> elements.

c. If there are double quotation marks around the value of the
currentSchema attribute, you must remove them. For example,
change currentSchema=’"wrkschem"’ or currentSchema="
&quot;wrkschem&quot;" to currentSchema=’wrkschem’.

WebSphere Application Server full profile:

a. Sign in to WebSphere Application Server administrative console.
b. Click Resources > JDBC > Data sources.
c. For each database with the JNDI name jdbc/WorklightDS or

jdbc/WorklightReportsDS, possibly with a suffix:
1) Select the data source
2) Click Additional properties > Custom properties.
3) Select the currentSchema property.
4) If the value is not empty, remove the double quotation marks

around the value. For example, change the value "wrkschem" to
wrkschem.

5) Click OK.
6) Click Save to save the changes.

Apache Tomcat:

a. Edit the server.xml file in the conf directory.
b. In the <Resource name="jdbc/WorklightDS" .../> and <Resource

name="jdbc/WorklightReportsDS" .../> elements, remove the
double quotation marks around the value of the currentSchema
connection property in the url attribute, if this property is present.
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For example, change url=’jdbc:db2://
dbserver.example.com:50000/WRKLGHT:currentSchema="wrkschem";’
to url=’jdbc:db2://dbserver.example.com:50000/
WRKLGHT:currentSchema=wrkschem;’.

Updating the configuration of your server farm
About this task

You need to update the configuration if you configure a server farm to run IBM
MobileFirst Platform Foundation for iOS in V6.2.0. The configuration of a farm in
V7.1.0 is simpler.

WebSphere Application Server Liberty
Optionally, you can remove some unused JNDI properties and configure
the heartbeat rate and timeout values.
v The following JNDI properties in the server.xml file are not used any

more. You can remove them.
<jndiEntryjndiName="ibm.worklight.farm.type" value="File"/>
<jndiEntryjndiName="ibm.worklight.farm.definition.location" value="<plugin xml file location>"/>

v You can configure the heartbeat rate and timeout values by defining the
following JNDI properties in the server.xml file.

<jndiEntryjndiName="worklight.admin.farm.heartbeat" value="<heartbeat rate in minutes>"/>
<jndiEntryjndiName="ibm.worklight.admin.farm.missed.heartbeats.timeout"
value="<number of missed heartbeats before considering the server as being down>"/>

Tomcat
Optionally, you can remove some unused JNDI properties and configure
the heartbeat rate and timeout values.
v The following JNDI properties in the server.xml file are not used any

more. You can remove them.
<Environment name="ibm.worklight.farm.type" value="File" type="java.lang.String" override="false"/>
<Environment name="ibm.worklight.farm.definition.location" value="<plugin xml file location>"
type="java.lang.String" override="false"/>

v You can configure the heartbeat rate and timeout values by defining the
following JNDI properties in the server.xml file.

<Environment name="worklight.admin.farm.heartbeat" value="<heartbeat rate in minutes>"
type="java.lang.String" override="false"/>

<Environmentname="ibm.worklight.admin.farm.missed.heartbeats.timeout"
value="<number of missed heartbeats before considering the server as being down>"
type="java.lang.String"override="false"/>

WebSphere Application Server

Required modifications

You must set new JNDI properties in MobileFirst Administration
Services applications and every MobileFirst runtime application.
1. Open the WebSphere Application Server administration console.
2. On the navigation pane, select Applications > Application

Types > Websphere enterprise applications.
3. Select the application that you want to configure.
4. In Web Module Properties, click Environment entries for Web

Modules to display the JNDI properties.
5. Set the ibm.worklight.admin.jmx.user property to a user name

that has access to the SOAP connector.

3-10 IBM MobileFirst Platform Foundation for iOS V7.1.0: Upgrading MobileFirst Server from V6.2.0 to V7.1.0



6. Set the ibm.worklight.admin.jmx.pwd property to the password
of the user that you declared in the
ibm.worklight.admin.jmx.user property.

7. Verify that the ibm.worklight.admin.jmx.connector property is
set to SOAP.

Optional modifications
You can configure the heartbeat rate and timeout values by
defining the worklight.admin.farm.heartbeat and
ibm.worklight.admin.farm.missed.heartbeats.timeout JNDI
properties in the MobileFirst Administration Services application.

Special configurations
Procedure
1. If Activate Token Licensing is selected when you run Installation Manager to

upgrade the product installation to V7.1.0, you need to configure your server
for token licensing. Select Activate Token Licensing only if you have a
contract to use token licensing.

2. If your application server is WebSphere Application Server V7.0, you must add
the configuration property
com.ibm.ws.webcontainer.invokerequestlistenerforfilter = true. For more
information about how to add this property, see Configuring WebSphere
Application Server V7.0. This setting is needed for the runtime environment
(the Project WAR File) in V7.1.0.

Verifying the updates
Procedure
1. Log in to MobileFirst Operations Console.
2. Select the menu Hello, your_name > About on the upper right of the window.
3. Verify the version. It must match the fix pack or interim fix version that is

installed.
For example, if the interim fix 7.1.0.0-IF201510051721 is installed, the version
displays in About must be Server version: 7.1.0.00.20151005-1721.

4. Run wladm command with show versions command to verify the version of the
worklight-jee-library.jar library. In the output, the value of productVersion
and the value of serverVersion for each runtime environment ought to
correspond to the fix pack or interim fix version. For more information about
the commands, see Administering MobileFirst applications through the
command line and Commands for troubleshooting.

Upgrading Application Center
About this task

You can update this component in two ways:
v Directly with Installation Manager
v Manually

The updating procedure depends on the method you used at the initial installation.

The component is installed with Installation Manager
Application Center is automatically upgraded when you run Installation
Manager to update your installation. There is no further action required.

The component is installed manually
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v You can upgrade manually.
v An attempt to upgrade with Ant tasks might fail. The target of the Ant

tasks to upgrade the component assume that the installation is made in
a certain way.

Important:

v Upgrade the database by a database administrator:
In some cases, you might want to upgrade the databases manually. For example,
to set some non-default properties to the new tables created. This is not possible
if you upgrade Application Center with Installation Manager since the database
scripts are only available after you run Installation Manager. However, if you
upgrade the Application Center manually before you run Installation Manager, it
would detect that the tables are upgraded to V7.1.0. Installation Manager looks
at the value in the table (such as APPCNTR_VERSION) and would not attempt to
upgrade them. When you use Ant tasks, do not run the database target if the
databases are already updated manually. If you do run them, the Ant tasks
would detect that the schema is in V7.1.0.

v WebSphere Application Server specifics:
– The user that runs the upgrade needs to have at least the privileges of a

Deployer role to update the WAR files.
v Upgrade the databases:

– This step is optional if you upgrade with Installation Manager.
– Back up the databases for Application Center. The migration scripts delete

some data in your database and the operation cannot be undone. If you
decide to roll back the upgrade of Application Center, you need this backup.

– If you upgrade manually, the upgrade scripts can be found in
product_install_dir/ApplicationCenter/databases folder.
1. Upgrade the database from V6.2.0 to V6.3.0.

- upgrade-appcenter-62-63-db2.sql

- upgrade-appcenter-62-63-mysql.sql

- upgrade-appcenter-62-63-oracle.sql

2. Then, upgrade the database from V6.3.0 to V7.0.0.
- upgrade-appcenter-63-70-db2.sql

- upgrade-appcenter-63-70-mysql.sql

- upgrade-appcenter-63-70-oracle.sql

3. Lastly, upgrade the database from V7.0.0 to V7.1.0.
- upgrade-appcenter-70-71-db2.sql

- upgrade-appcenter-70-71-mysql.sql

- upgrade-appcenter-70-71-oracle.sql

Upgrading manually
Procedure
1. Locate the Application Center WAR files. The new versions of these files are in

product_install_dir/ApplicationCenter/console folder.
2. Replace the appcenterconsole.war and applicationcenter.war files in your

application server.

Note: For WebSphere Application Server full profile, make sure that the
configured values of the JNDI properties are not erased.
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3. On WebSphere Application Server Network Deployment, do a full
synchronization of the servers.

4. Restart the application servers for these updates to take effect.

Installing and upgrading of Application Center with Ant tasks
About this task

It is possible to move from an installation and upgrading of Application Center
with Installation Manager to an installation with Ant task.

The high-level procedure is as follows:
1. Uninstall the product and Application Center with Installation Manager.
2. Reinstall the product without installing Application Center with Installation

Manager.
3. Upgrade the databases. You might want to back up the databases for

Application Center. The migration scripts delete some data in your database
and the operation cannot be undone. If you decide to roll back the upgrade of
Application Center, you need this backup.

4. Install Application Center with an Ant file.
5. Keep the Ant file for future usage (such as applying a fix pack).
6. Configure the newly installed Application Center.

Procedure
1. Uninstall the product and Application Center with Installation Manager.

a. Run Installation manager to uninstall your existing product installation.
v Uninstallation process removes Application Center that is installed in the

application server.
v The databases are not modified.
v The installation of MobileFirst Server or MobileFirst Operational

Analytics are not modified on the application server.
2. Install IBM MobileFirst Platform Foundation for iOS V7.1.0 with Installation

Manager without installing Application Center.
a. For a silent installation, use the install-no-appcenter.xml file that is listed

in Working with sample response files for IBM Installation Manager.
3. Make a copy of the file you selected.
4. Open the copied XML file with a text editor or XML editor. Modify the

following elements:
a. The repository element that defines the repository list.

Create a repository entry for the repository of IBM MobileFirst Platform
Foundation for iOS V7.1.0 and also the repository of the fix pack that you
plan to install.
The fix packs are delivered as delta installers and cannot be installed if the
base version is not among the listed repositories. If you plan to update an
existing IBM MobileFirst Platform Foundation for iOS V7.1.0 (apply an
interim fix), the repository of product is not needed.
However, if you plan to make a fresh installation of IBM MobileFirst
Platform Foundation for iOS V7.1.0 with an interim fix, then you need both
repositories. For example, if you decompress the base installer in
710_installer_directory folder, the repository file to enter is
710_installer_directory/MobileFirst_Platform_Server/disk1/
diskTag.inf. If you decompress the interim fix file in ifix_directory folder,
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the repository file to enter is ifix_directory/
MobileFirst_Platform_Server/disk1/diskTag.inf.

b. Uncomment the line <data key=’user.licensed.by.tokens’
value=’false’/>. Set the value to true if you have a contract to use token
licensing with the Rational License Key Server. Otherwise, set the value to
false.
If you activate token licensing, make sure that the Rational License Key
Server is configured, and enough tokens can be obtained to run MobileFirst
Server and the applications it serves. Otherwise, the MobileFirst Server
administration application and the runtime environment cannot be run.

Restriction: After the decision is made to activate token licensing or not, it
cannot be modified. If you run an upgrade with the value true, and later
another upgrade with the value false, the second upgrade fails.

c. Review the profile identity and the installation location. Make sure that the
profile identity and the installation location do not collide with another
installation on your computer.
v This line: <profile id=’IBM MobileFirst Platform Server’

installLocation=’/opt/IBM/MobileFirst_Platform_Server’>

v And this line: <offering id=’com.ibm.mobilefirst.foundation.server’
version=’7.1.0.00-20150913-2345’ profile=’IBM MobileFirst Platform
Server’ features=’main.feature’ installFixes=’none’/>

v To review the profile identity and the installation directories that are
known to Installation Manager, you can type the command:
installation_manager_path/eclipse/tools/imcl listInstallationDirectories -verbose

d. Update the version attribute to and set it to the version that you plan to
install.
v If you install the base version that is downloaded from Passport

Advantage, you do not need to do anything. The silent response files
contain the particular version that is posted on the Passport Advantage.

v If you install the base version with an interim fix (such
as7.1.0.0-IF201510051721), replace <offering
id=’com.ibm.mobilefirst.foundation.server’ version=’7.1.0.00-
20150913-2345’ profile=’IBM MobileFirst Platform Server’
features=’main.feature’ installFixes=’none’/> by <offering
id=’com.ibm.mobilefirst.foundation.server’ version=’7.1.0.00-
20151005-1721’ profile=’IBM MobileFirst Platform Server’
features=’main.feature’ installFixes=’none’/>.

Installation Manager does not only use the repositories that are listed in the
installation file, but also the repositories that are installed in its preferences.
Specifying the version attribute in the offering element is optional.
However, by specifying it, you ensure that the interim fix that is defined is
the version that you intend to install. This specification overrides the other
repositories with interim fixes that are listed in the Installation Manager
preferences.

5. Select the sample Ant file for Application Center that corresponds to your
application server and database.
The sample Ant files are available in product_install_dir/ApplicationCenter/
configuration-samples folder. The naming conventions are similar to the
sample ant files for MobileFirst Server.

6. Edit the parameters. For the database, use the same parameters (same database,
user, and schema) as the parameters that are used at the previous installation
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with Installation Manager. By using the same credentials, the existing database
can be upgraded and connected to the new installation.

7. Run the databases target to upgrade the database. For example,
product_install_dir/shortcuts/ant -f your_ant_file.xml databases

Alternatively, you can upgrade the database manually as explained earlier in
this section.

8. Run the install target to deploy Application Center to your application server.
For example,
product_install_dir/shortcuts/ant -f your_ant_file.xml install

9. Configure Application Center. For more information, see Configuring
Application Center after installation.

Reinstalling MobileFirst Operational Analytics
About this task

In V7.1.0, IBM Worklight Analytics Platform is repackaged and renamed as
MobileFirst Operational Analytics. The component is delivered as two separate
WAR files instead of a single WAR file. One for the analytics console and one for
the analytics service. Both WAR files are protected by the security roles. You need
to uninstall the old version and install the one from V7.1.0.

Procedure
1. Uninstall IBM Worklight Analytics Platform V6.2.0.
2. Install MobileFirst Operational Analytics V7.1.0 as described in Installing the

IBM MobileFirst Platform Operational Analytics.
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Support and comments

For the entire IBM MobileFirst Platform documentation set, training material and
online forums where you can post questions, see the IBM website at:

http://www.ibm.com/mobile-docs

Support

Software Subscription and Support (also referred to as Software Maintenance) is
included with licenses purchased through Passport Advantage and Passport
Advantage Express. For additional information about the International Passport
Advantage Agreement and the IBM International Passport Advantage Express
Agreement, visit the Passport Advantage website at:

http://www.ibm.com/software/passportadvantage

If you have a Software Subscription and Support in effect, IBM provides you
assistance for your routine, short duration installation and usage (how-to)
questions, and code-related questions. For additional details, consult your IBM
Software Support Handbook at:

http://www.ibm.com/support/handbook

Comments

We appreciate your comments about this publication. Please comment on specific
errors or omissions, accuracy, organization, subject matter, or completeness of this
document. The comments you send should pertain to only the information in this
manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact
your IBM branch office, your IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or
distribute your comments in any way it believes appropriate without incurring any
obligation to you. IBM or any other organizations will only use the personal
information that you supply to contact you about the issues that you state.

Thank you for your support.

If you would like a response from IBM, please provide the following information:
v Name
v Address
v Company or Organization
v Phone No.
v Email address
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Notices

This information was developed for products and services offered in the US. This
material might be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

The performance data and client examples cited are presented for illustrative
purposes only. Actual performance results may vary depending on specific
configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
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Each copy or any portion of these sample programs or any derivative work must include a copyright notice as follows:
© (your company name) (year).
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. _enter the year or years_.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Node.js is a trademark of Joyent, Inc. and is used with its permission. This
documentation is not formally endorsed by or affiliated with Joyent.

Other company products or service names may be trademarks or service marks of
others.

This document may not be reproduced in whole or in part without the prior
written permission of IBM.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.
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Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement
IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use
session cookies that collect session information (generated by the application
server). These cookies contain no personally identifiable information and are
required for session management. Additionally, persistent cookies may be
randomly generated to recognize and manage anonymous users. These cookies
also contain no personally identifiable information and are required.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent. For more information about the use of various technologies, including
cookies, for these purposes, see IBM’s Privacy Policy at http://www.ibm.com/
privacy and IBM’s Online Privacy Statement at http://www.ibm.com/privacy/
details the section entitled “Cookies, Web Beacons and Other Technologies” and
the “IBM Software Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.
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